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1. Introduction

1.1. Welcome

Welcome into SociometryPro - the computer-calculating program for the sociometric domain! 
The program is designed for those, who works in research of people relations. They can be 
project managers working in building a cohesive human team for participating in any complex 
projects. SociometryPro is designed and developed by LeDiS Group.

SociometryPro is a computer realization of famous sociometric method of J. L. Moreno (the 
USA). It can be useful for creating of people groups, which can solve any project tasks and 
pass through any difficulties. You will control the integrity of a group with your experience and 
SociometryPro at any moment of time. You will be able quickly find out special methods for 
prevention of any crisis situations, which can raise in a group.

The purposes of SociometryPro are:

Define a group structure and dynamics of its inner relations changes;

Make cohesive people groups to realize any hard projects in the planned time;

Optimize control methods in relation to a group;

Optimize psychological climate in a group;

Make the diagnostics of inner relations change while the outside factors change (for example, 
engaging and resigning out of employees, change of employee salaries, etc).

1.2. Why SociometryPro

Let's presume that you are a project manager. You know that the success in your project can 
give you a lot of goods. They are: a lot of money, career growth or at least the big satisfaction 
from your work. And therefore you want reach quickly the project purposes. You start engaging
of employees, which all are the greatest professionals. You promise them big salaries. But 
something in the project breaks your expectations. Problems arrive in the project; the collective
is being separated to several groups. And it results in the losses: you loss money; you get the 
feeling of full defeat; the employees leave the project; etc.

Could you defend yourself from arriving of such situation? We think that 
you could! SociometryPro (a computer realization of famous J.L.Moreno 
method) is able to help you! With it you get a tool that can help you in 
creating of strong human groups and control by any changes in them. You 
will always know what happens in a group! At any time you can design the 
effective controlling methods in short time!

SociometryPro helps:

Economize time (because of computer calculating of the sociometric results);

Economize money (because of economizing of time);

Get fine visualization of a group state (in a view of indexes charts, graphs and targets);

Generate reports.
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But, please, don't forget that SociometryPro is only a tool. The program can calculate and 
visualize a testing group but never will be able define for you what you should do in case of a 
crisis situation. Only your experience will help you in this. And we hope that SociometryPro 
could help you.

1.3. Hardware & Software Requirements

Type: Windows application.

Hardware requirements: PC-compatible computer, at least 4 Mb RAM, 2 Mb HDD, keyboard, 
mouse, monitor.

Software requirements: OS - Windows (any of - 95, 98, NT, 2000, Me, XP). As well we 
recommend using of Microsoft Office (any of - 95, 97, 2000, XP) and Microsoft Internet 
Explorer (from version 4.0 and higher).

1.4. Tech. Support

You can send any questions and suggestions to:

support@ledisgroup.com

1.5. Contacts

The official site of LeDiS Group:

http://www.ledisgroup.com

Tech. support for registered users:

support@ledisgroup.com

1.6. Thanks

1. Free IrfanView v3.70 helped create documents in the development of SociometryPro:

http://www.irfanview.com

2. Free Inno Setup Compiler v2.0.19(b) helped create installation program for SociometryPro:

http://www.innosetup.com
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2. Sociometry Milestones with SociometryPro

2.1. Defining a criterion

Criterion is a question or a statement, with which an instructor asks people in a group. If the 
people relations in the group are hard and contain any negative emotional features then 
integrity of the group can be violated. It can result in the violating of the normal work contacts: 
for example, to the incomprehension among members or to the attempts of evident and hidden
sabotage. A criterion may be defined as follows: "Who is more preferable for work in the 
project?"

A criterion can be complex. But don't overload this milestone by hard criteria. It is very 
important to define accurately a criterion for sociometric testing.

2.2. Choices

Let's presume that employees, who have been tested, answered the criterion what they think 
about others in the group. For instance, they chose who is more preferable for work together or
else, which is least preferable. Of course, the more honest answers the more precise results.

At the picture example below you can see that all people want work with Cat, two of them want
work with Sam and two don't want work with John.

2.3. Visualization of results

Special graphical abilities of SociometryPro program provide evaluating of group integrity, find 
out more about its structure, define the hidden leaders (who are able to change the 
psychological climate), etc. The math abilities provide calculated evaluations based on the 
sociometric testing.

2.4. Conclusions

Based on the sociometry testing results you can:

Describe the social and psychological climate in a group;

Page 6 from 53

http://www.ledisgroup.com/


SociometryPro's User Guide LeDiS Group, http://www.ledisgroup.com

Estimate the tensions in a group;

Estimate relationships or a group;

Understand, who is rejected and doesn't participate in overall work;

Understand, who is more preferable and consolidates the group;

Etc.

2.5. Overcoming crisis situations

Your conclusions about group state can result in creating of suggestions directed to improving 
of the inner climate in a group. You can do following in this case:

Tuning of the contacts with the real group leaders;

Adaptation of the rejected persons (who is never chosen); 

Adaptation of the negative leaders (who is always rejected);

Etc.

2.6. Repeating the steps 3.1-3.5

Periodic repeating of the previous steps is important if you want to evaluate the change 
dynamics of the group integrity. The more often the persons choose each to other in any 
situations the better climate in the group and higher its integrity.

For improving of the group effectiveness you can reform the group in according the mutual 
emotional reactions. It can be useful for consolidating of work contacts. As a last case you can 
accept decision about dismissing of the group. It relates only those groups, which are hopeless
in result of your evaluating.
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3. SociometryPro interface

3.1. Structure

SociometryPro has a multi-document interface. The main window including its left frame 
arrives when the program is started (if authorization mode is off).  The left frame displays a list 
of objects. The most of these objects presents main sociometric entities. They are clients and 
criteria groups, clients and criteria, investigations. The frame exists while the program is 
executing.

The right frame of the main window can display different child windows of SociometryPro, 
which can be opened for an investigation node.

At any time the only main window and a lot of child windows can be displayed.

The main window interface contains the following elements:

Main menu;

Toolbar;

Statusbar;

A set of child windows, which can display specific information.

Different parts of SociometryPro can include special context menus that can be called by 
pressing mouse right button over those parts. In general the context menus duplicate the main 
menu items. The context menus provide more comfortable work in the program.

Menu items and toolbar buttons can be enabled or disabled depending on type of the selected 
node in the objects tree frame.

All string resources (such as dialogs messages, toolbar hits, buttons labels, etc) are saved in 
the special file "language.dat". Any of them can be changed, for example, in process of 
SociometryPro translating into another language. One must be mentioned that this document 
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uses string resources saved in the file "language.dat" that you downloaded from LeDiS Group 
site.

3.2. Main menu

Main menu is a simple panel in the top of SociometryPro main window. The panel contains list 
of items that presents all possible operations, which are provided in the program.

The menu panel includes the following menu groups:

1. File.

2. Edit.

3. View.

4. Object.

5. Report.

6. Window.

7. Help.

"File" group includes the following menu items:

Create - provides creating a new empty project.

Open - provides opening an existing project.

Save - provides saving the opened project in its file (it is enabled if the project is changed 
only).

Save as - provides saving the opened project in another file that should be pointed by user.

Close - provides closing the opened project.

Open again - provides opening a project from the history of last opened ones (last opened 
projects are displayed as submenu items; it is enabled if user opened any projects at the 
current computer and there is value more 0 in "Maximal number of projects in 'Open again'" 
field).

Import client group - provides importing the clients group data from a file with extension 
"sgr" created in result of previous export process.

Export client group - provides exporting a clients group in a file with extension "sgr".

Print - provides printing the image in the active child window: choices, indexes, graph, target 
(it is enabled if a child window is opened only).

Exit - provides closing the SociometryPro program.

"Edit" group includes the following menu items:

Users - provides defining the program's users.

Find - provides defining the search rules and finding the first object in the objects tree that 
satisfies to these rules.

Find next - provides finding the next object in the objects tree that is located after first found 
object and satisfies to mentioned above search rules as well (it is enabled if "Find" operation 
was activated only).
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Toolbars - provides defining the visibility of toolbar parts.

Options - provides an accurate tuning the SociometryPro interface.

"View" group includes the following menu items:

Save choices - provides saving the current choices in the active choices window (it is 
enabled if a choices window is active only).

Clear all choices - provides removing all choices (it is enabled if a choices window is active 
only).

Positive choices - provides displaying the sociometric results for positive choices (it is 
enabled if a visualization window is active only: indexes, graph, target).

Negative choices - provides displaying the sociometric results for negative choices (it is 
enabled if a visualization window is active only: indexes, graph, target).

Any choices - provides displaying the sociometric results for both types of choices (it is 
enabled if a graph window is active only).

"Object" group includes the following menu items:

Create - provides creating a child object for selected node in the objects tree. If "Clients" node
is active, then a new clients group will be created, a clients group node - a new client in this 
group, "Criteria" node - a new criteria group, a criteria group node - a new criterion in this 
group, "Investigations" node - a new investigation. In this way the menu item title for different 
selected nodes changes to "Create clients group", "Create client", "Create criteria group", 
"Create criterion" or "Create investigation".

Change - provides changing the selected object's attributes in the objects tree. The menu 
item title for different selected nodes changes to "Change clients group", "Change client", 
"Change criteria group", "Change criterion" or "Change investigation".

Delete - provides removing the selected object in the objects tree. The menu item title for 
different selected nodes changes to "Delete clients group", "Delete client", "Delete criteria 
group", "Delete criterion" or "Delete investigation".

Choices - provides opening "Choices" window for pointing of choices made by clients for 
selected investigation node (it is enabled for selected investigation node only).

Indexes - provides opening "Indexes" window for displaying of group and private indexes 
charts for selected node (it is enabled for selected investigation node only).

Graph - provides opening "Graph" window for displaying of a graph for selected node (it is 
enabled for selected investigation node only).

Target - provides opening "Target" window for displaying of a target for selected node (it is 
enabled for selected investigation node).

"Report" group includes the following menu items:

Current object - provides creating a report for selected node (it is enabled for selected clients
group, client, criteria group, criterion or investigation node only).

Client group report - provides creating a report for selected clients group node (it is enabled 
for selected clients group node only).
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Client report - provides creating a report for selected client node (it is enabled for selected 
client node).

Criterion group report - provides creating a report for selected criteria group node (it is 
enabled for selected criteria group node only).

Criterion report - provides creating a report for selected criterion node (it is enabled for 
selected criterion node only).

Investigation report - provides creating a report for selected investigation node (it is enabled 
for selected investigation node only).

"Window" group includes the following menu items:

Cascade - provides arranging all child windows in cascade style.

Tile - provides arranging all child windows in tile style.

As well bottom part of menu "Window" includes menu items that has the same captions as the 
titles of opened child windows. Any such item provides activating of the related child window.

"Help" group includes the following menu items:

Context - provides opening the helper subsystem.

Home page - provides opening Internet Explorer at the home page of LeDiS Group web site.

Support - provides opening of email program for sending a letter to the Support Service of 
LeDiS Group.

About - provides opening the SociometryPro info window ("About").

3.3. Toolbar

SociometryPro toolbar is several buttons sets, located in the top of main window under the 
main menu panel. A toolbar button duplicates the functions of a main menu item.

Toolbar buttons sets can be moved to a new location by mouse. To do it move mouse cursor 
to the left border of a buttons set, press left mouse button and move the cursor to the 
necessary location. Thus the set will be moved to a new location. In the same way the buttons 
set can be returned back.

Buttons sets can be visible or hidden. Deactivate a main menu item in "Edit/Toolbar" or an 
elements list in "Toolbar tuning" window (this window can be called by activating of 
"Edit/Toolbars/Toolbars tuning" main menu item or toolbar button ).
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There are the following buttons sets in the toolbar:

1. Project.

2. File.

3. Edit.

4. View.

5. Object.

6. Report.

"Project" set contains the following buttons:

 - provides creating a new empty project (the same as "Create" main menu item in "File" 
menu group).

 - provides opening an existing project (the same as "Open" main menu item in "File" menu 
group).

 - provides saving the opened project in its file (it is enabled if the project is changed only; the 
same as "Save" main menu item in "File" menu group).

 - provides saving the opened project in another file that should be pointed by user (the same 
as "Save as" main menu item in "File" menu group).

 - provides closing the opened project (the same as "Close" main menu item in "File" menu 
group).

"File" set contains the following buttons:

  - provides importing the clients group data from a file with extension "sgr" created in 
result of previous export process (the same as "Import client group" main menu item in "File" 
menu group).

  - provides exporting a clients group in a file with extension "sgr". (the same as "Export 
client group" main menu item in "File" menu group).
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  - provides printing the image in the active child window: choices, indexes, graph, target (it
is enabled if a child window is opened only; the same as "Print" main menu item in "File" 
menu group).

 - provides closing the SociometryPro program (the same as "Exit" main menu item in "File" 
menu group).

"Edit" set  contains the following buttons:

  - provides defining the program's users (the same as "Users" main menu item in "Edit" 
menu group).

  - provides defining the search rules and finding of first object in the objects tree that 
satisfies to these rules (the same as "Find" main menu item in "Edit" menu group).

  - provides finding the next object in the objects tree that is located after first found object 
and satisfies to mentioned above search rules as well (it is enabled if "Find" operation was 
activated only;  the same as "Find next" main menu item in "Edit" menu group).

 - provides defining the visibility of toolbar parts (the same as "Toolbars" main menu item in 
"Edit" menu group).

  - provides an accurate tuning the SociometryPro interface (the same as "Options" main 
menu item in "Edit" menu group).

"View" set  contains the following buttons:

  - provides saving the current choices in the active choices window (it is enabled if a 
choices window is active only; the same as "Save choices" main menu item  in "View" menu 
group).

  - provides removing all choices (it is enabled if a choices window is active only; the same 
as "Clear all choices" main menu item in "View" menu group).

 - provides displaying the sociometric results for positive choices (it is enabled if a 
visualization window is active only: indexes, graph, target; the same as "Positive choices" 
main menu item in "View" menu group).

 - provides displaying the sociometric results for negative choices (it is enabled if a 
visualization window is active only: indexes, graph, target; the same as "Negative choices" 
main menu item in "View" menu group).

  - provides displaying the sociometric results for both types of choices (it is enabled if a 
graph window is active only; the same as "Any choices" main menu item in "View" menu 
group).

"Object" group includes the following menu items:

  -  - provides creating a child object for selected one in the objects tree. if "Clients" node is
active, then a new clients group will be created, a clients group node - a new client in this 
group, "Criteria" node - a new criteria group, a criteria group node - a new criterion in this 
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group, "Investigations" node - a new investigation (the same as "Create" main menu item in 
"Object" menu group).

  - provides changing the selected object's attributes in the objects tree (the same as 
"Change" main menu item in "Object" menu group).

  - provides removing the selected object in the objects tree (the same as "Delete" main 
menu item in "Object" menu group).

  - provides opening "Choices" window for pointing of choices made by clients for selected 
investigation node (it is enabled for selected investigation node only; the same as "Choices" 
main menu item in "Object" menu group).

  - provides opening "Indexes" window for displaying of group and private indexes charts 
for selected node (it is enabled for selected investigation node only; the same as "Indexes" 
main menu item in "Object" menu group).

  - provides opening "Graph" window for displaying of a graph for selected node (it is 
enabled for selected investigation node only; the same as "Graph" main menu item in 
"Object" menu group).

 - provides opening "Target" window for displaying of a target for selected node (it is enabled 
for selected investigation node; the same as "Target" main menu item in "Object" menu 
group).

"Report" set  contains the following buttons:

  - provides creating a report for selected node (it is enabled for selected clients group, 
client, criteria group, criterion or investigation node only; the same as "Current object" main 
menu item in "Report" menu group).

  - provides creating a report for selected clients group node (it is enabled for selected 
clients group node only; the same as "Client group report" main menu item in "Report" menu 
group).

  - provides creating a report for selected client node (it is enabled for selected client node; 
the same as "Client report" main menu item in "Report" menu group).

  - provides creating a report for selected criteria group node (it is enabled for selected 
criteria group node only; the same as "Criterion group report" main menu item in "Report" 
menu group).

  - provides creating a report for selected criterion node (it is enabled for selected criterion 
node only; the same as "Criterion report" main menu item in "Report" menu group).

  - provides creating a report for selected investigation node (it is enabled for selected 
investigation node only; the same as "Investigation report" main menu item in "Report" menu 
group).
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3.4. Statusbar

Statusbar displays useful info about the selected node of the objects tree. Data for the nodes 
are displayed as it's shown in relation to the following table:

Selected node Statusbar data

"All objects" node's name

"Clients" node's name

of a clients group clients group's title; the number of clients in it; the number of 
investigations, in which the group is acted

of a client full client's name; the number of investigations, in which the client is acted

"Criteria" node's name

of a criteria group criteria group's title; the number of criteria in it

of a criterion criterion's title; the number of investigations, in which the criterion is acted

"Investigations" node's name

of an investigation investigation's title; the maximal number of choices that may be made by 
any client in investigation's group; are allowed or no the negative choices 
in the investigation

3.5. Hot keys

Keyboard hot keys automate the most frequent user's operations. SociometryPro reserves the 
following keyboard hot keys:

Ctrl-E - provides closing of SociometryPro program;

Ctrl-F - provides defining of search rules and finding of first object in the objects tree that 
satisfies to these rules;

F3 - provides finding of next object in the objects tree that is located after first found object and 
satisfies to mentioned above search rules as well;

INSERT - provides creating of a child object for selected one in the objects tree (the operation 
is enabled if one of the following nodes is active only: "Clients", node of a clients group, 
"Criteria", "Investigation");

ENTER - provides change of the attributes of selected object in the objects tree (the operation 
is enabled if one of the following nodes is active only: node of a clients or criteria group, node 
of a client or criterion or node of an investigation);

DELETE - provides removing of selected object in the objects tree (the operation is enabled if 
one of the following nodes is active only: node of a clients or criteria group, node of a client or 
criterion or node of an investigation);

Ctrl-C - provides opening of "Choices" window for pointing of choices made by clients for 
selected node (it is enabled for a selected investigation node only);
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Ctrl-I - provides opening of "Indexes" window for displaying of group and private indexes 
charts for selected node (it is enabled for selected investigation node only);

Ctrl-G - provides opening of "Graph" window for displaying of a graph for selected node (it is 
enabled for selected investigation node only);

Ctrl-T - provides opening of "Target" window  for displaying of a target for selected node (it is 
enabled for selected investigation node only);

Ctrl-N - provides creating of a report for selected node (it is enabled for selected clients group, 
client, criteria group, criterion or investigation node only).

3.6. Context help

Context help is available from any part of SociometryPro by pressing F1.

Installation program sets up helper files during the installation process at user's computer.

Call the context help by "Help/Context" main menu item or toolbar button .
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4. Working in SociometryPro

4.1. Starting the program

SociometryPro can display the special window for selecting an action by user on the start. This
is "Select action" window that provides select one of the following actions:

Open last project (it provides opening of the last opened project)

Create new project (it provides creating of new empty project)

Open an existing project (it provides opening a project that should be pointed by user)

For opening of an existing project select "Open existing project" and input project file name in 
"File" field. As well you can press "Browse" button for opening of the special dialogue for 
selecting a project file. "File" and "Browse" controls are enabled if "Open existing project" is 
active only.

Deactivate "Show at start up" check box if you don't want opening a "Select action" window 
when the program is starting. As well you can do the same in "Parameters" window.

Press Yes button for making a selected action.

Press Cancel if you want the program do nothing. In this case no projects will be created or 
opened.

Press Help for opening of the context helper window.

4.2. Projects

4.2.1. Introduction in projects

SociometryPro project contains all data of SociometryPro, which is available for you at any 
moment. There are the following data here:

Clients groups;
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Clients;

Criteria groups;

Criteria;

Investigations;

Project users;

Project parameters.

A project can be saved in project file having "soi" extension. You can send the file to another 
computer by any available manner and work with this file in that computer if SociometryPro is 
installed there, of course.

There are the following available operations with a project:

Creating a new empty project (for this press "File/Create" main menu item or tool bar button ).

Opening an existing project (for this press "File/Open" main menu item or tool bar button ). 
You should input project file name making this operation.

Saving the opened project in current project file (for this press "File/Save" main menu item or 
tool bar button ). You can save the opened project only, in which some data were changed.

Saving the opened project in new project file (for this press "File/Save as" main menu item or 
tool bar button ).  You should input project file name making this operation.

Closing the opened project  (for this press "File/Close" main menu item or tool bar button ).

At any time you can open only one project. If you are opening a project while another project is
opened then the last project will be closed, and first will be opened.

4.2.2. Projects history

SociometryPro is able remember the list of last opened projects. The last opened project is 
always displayed in the top of the list.

You can see the projects history when you are moving the mouse cursor over "File/Open 
again" main menu item.

Projects history can contain 0-10 references to last opened projects. The number of references
can be set in "Parameters" window in "Maximal number of projects in 'Open again'".

If you set the field in 0 then "Open again" main menu item will be hided.

4.2.3. Authorization in a project

You can set an authorization mode in a SociometryPro project. In such project only user that 
input right login and password can access the data. Due to this the project data can be 
secured from an illegal use.

When a new project is created, the authorization mode in it is unchecked. In this way any user 
can access the project data. The authorization mode of the project can be set in "Parameters" 
window. For opening of this window, please, press "Edit/Options" main menu item or toolbar 

button . Set "Login and password control opening project" control in "Current project" 
group. Press OK button to confirm the authorization mode. Now if you close current project 
and open it again then "Input login & password" will be displayed.
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Input login and password of an authorized user (make sure that right keyboard modes are set).
When a new project is created, it has user "admin" with empty password ("") only.

Press OK button for confirming of project opening. It will result in arriving of the project data.

Press Cancel button if you don't want open the project.

Press Help for opening of the context helper window.

You can create new users in the opened project and authorize in future using those users 
logins and passwords.

We recommend change the password of "admin" user after creating a new project or replace 
this user.

You can unset the authorization mode again in "Parameters" window.

4.3. Users

4.3.1. Users list

For opening of a project with set authorization mode you should know login and password of 
the project user. Any such user is defined in the project users list.

After creating a new project it contains the only user with login "admin" and empty password.  
We recommend change its password or replace this user by another.

All SociometryPro project users have equal rights. They rights are open this project and add, 
change and remove any its data.

Users operations are available in "Users" window.
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You can in "Users" window:

Adding a new user (after pressing Add button);

Changing a user (after pressing Change button);

Deleting a user (after pressing Remove button);

Closing a window (after pressing Exit button).

You can't delete the only user in the project. If users list contains the only user, then Remove 
button is disable.

4.3.2. Adding a user

"Add user" window provides creating a new user.
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"Login" field can't be empty.

As well you can input:

Password;

Description (free form text).

Confirm the password in "Confirm" field. If the text in "Password" and "Confirm" fields isn't 
equal, new user will not be created. Make sure that right keyboard modes are set.

Press Add button for creating a new user.

Press Cancel button to cancel creating a user.

4.3.3. Changing a user

"Edit user" window provides changing an existing user.

"Login" field can't be empty.

As well you can input:

Password;

Description (free form text).

Confirm the password in "Confirm" field. If the text in "Password" and "Confirm" fields isn't 
equal, user's data will not be changed. Make sure that right keyboard modes are set.

Press Change button for changing a user.

Press Cancel button to cancel changing a user.

Deleting a user

"Confirm delete" window provides deleting an existing user.
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Press Yes button for deleting a user from the users list. Make sure pressing this button, 
because of there aren't any ways to restore the deleted data.

Press No button to cancel deleting a user.

4.4. Sociometric objects

4.4.1. Clients group

A clients group is one of the general sociometric objects of an investigation. It unites clients, 
which are choosing each to other while they are testing.

Adding a clients group

For adding a clients group select "Clients" node in the objects tree by mouse left button and do
one of the following:

Press "Object/Create client group" main menu item;

Press "Create client group" context menu item;

Press toolbar button ;

Press INSERT key.

Input the clients group name and description (optional) in the opened "Adding a clients group" 
window.
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Press OK button for creating a clients group.

Press Cancel button if you don't want create a clients group.

Press Help for opening of the context helper window.

Changing a clients group

For changing a clients group do double clicking over the node of the group. Or else select the 
clients group node by mouse left button or keyboard and do one of the following:

Press "Object/Change client group" main menu item;

Press "Change client group" context menu item;

Press toolbar button ;

Press ENTER key.

Change the clients group name and description (optional) in the opened "Changing a clients 
group" window (it is almost the same as "Adding a clients group" window).

Press OK button for changing a clients group.

Press Cancel button if you don't want change a clients group.

Press Help for opening of the context helper window.

Deleting a clients group

Only a clients group, which isn't related to an investigation, can be deleted.

For deleting a clients group do double clicking over the node of the group. Or else select the 
clients group node by mouse left button or keyboard and do one of the following:

Press "Object/Delete client group" main menu item;
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Press "Delete client group" context menu item;

Press toolbar button ;

Press DELETE key.

Press Yes button in the opened "SociometryPro" window for deleting a clients group.

Press Cancel button if you don't want delete a clients group.

Press Help for opening of the context helper window.

4.4.2. Import & export of a clients group

Let's presume that two or more users should work with some clients group. For this you don't 
need create equal clients groups on two and more computers. For working with the same 
clients group you will need do import and export of the clients group.

Exporting a clients group

For exporting a clients group you should:

1. Create a clients group on the source computer.

2. Select the clients group node in the objects tree and press "File/Export client group" main 

menu item or toolbar button .

3. Input file name, where the clients group will be saved, in the opened "Save clients group 
file" window. Make sure that such file doesn't exist, or else the export will not be done.

4. Press Save button for exporting a clients group.

SociometryPro should display a message about successful saving a clients group in the file.

Importing a clients group

Exported clients group file can be delivered to another computer, where SociometryPro 
program is installed. It could be done by means of floppy disk, laser disk, ZIP-disk, email, etc.

Now you can import the clients group at another computer. For this do the following:

1. Press "File/Import client group" main menu item or toolbar button  at the target 
computer.

2. Input the file name, which you will import a clients group from, in the opened "Open clients 
group file" window.

4. Press Open button.
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SociometryPro should display a message about successful loading a clients group from the 
file. In this case the node of the imported clients group will be displayed in the list of child 
nodes of "Clients" node.

4.4.3. Client

Client is a member of a group that is participated in sociometric testing. Clients are united in 
clients groups.

Adding a client

For adding a client select the node of clients group, in which you want add the client, and do 
one of the following:

Press "Object/Create client" main menu item;

Press "Create client" context menu item;

Press toolbar button ;

Press INSERT key.

Input the client full name and description (optional) in the opened "Adding a client" window. As 
well you can input the client's sex and birthday (or age in years).

You can quickly input the client's age by changing "Age" field. "Birthday" and "Age" fields are 
depending on each to other. You can use a field, which is more appropriate for you.

Press OK button for creating a client.

Press Cancel button if you don't want create a client.

Press Help for opening of the context helper window.

Changing a clients group
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For changing a client do double clicking over the node of the client. Or else select the client 
node by mouse left button or keyboard and do one of the following:

Press "Object/Change client" main menu item;

Press "Change client" context menu item;

Press toolbar button ;

Press ENTER key.

Change the client data in the opened "Changing a client" window (it is almost the same as 
"Adding a client" window).

Press OK button for changing a client.

Press Cancel button if you don't want change a client.

Press Help for opening of the context helper window.

Deleting a client

Only a client, who isn't related to an investigation, can be deleted.

For deleting a client do double clicking over the node of the client. Or else select the client 
node by mouse left button or keyboard and do one of the following:

Press "Object/Delete client" main menu item;

Press "Delete client" context menu item;

Press toolbar button ;

Press DELETE key.

Press Yes button in the opened "SociometryPro" window for deleting a client.

Press Cancel button if you don't want delete a client.

Press Help for opening of the context helper window.

4.4.4. Criteria group

A criteria group unites criteria in according with features defined by user.

You can both create a criteria group, in which any criteria can be created, and create several 
criteria groups, for example, "Main criteria", "New criteria", "Project 'Alpha' criteria", etc. It can 
be useful if you are working with a lot of criteria.

Adding a criteria group
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For adding a criteria group select "Criteria" node in the objects tree by mouse left button and 
do one of the following:

Press "Object/Create criterion group" main menu item;

Press "Create criterion group" context menu item;

Press toolbar button ;

Press INSERT key.

Input the criteria group name and description (optional) in the opened "Adding a criteria group" 
window.

Press OK button for creating a criteria group.

Press Cancel button if you don't want create a criteria group.

Press Help for opening of the context helper window.

Changing a criteria group

For changing a criteria group do double clicking over the node of the group. Or else select the 
criteria group node by mouse left button or keyboard and do one of the following:

Press "Object/Change criterion group" main menu item;

Press "Change criterion group" context menu item;

Press toolbar button ;

Press ENTER key.

Change the criteria group name and description (optional) in the opened "Changing a criteria 
group" window (it is almost the same as "Adding a criteria group" window).
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Press OK button for changing a criteria group.

Press Cancel button if you don't want change a criteria group.

Press Help for opening of the context helper window.

Deleting a criteria group

Only a criteria group, which isn't related to an investigation, can be deleted.

For deleting a criteria group do double clicking over the node of the group. Or else select the 
criteria group node by mouse left button or keyboard and do one of the following:

Press "Object/Delete criterion group" main menu item;

Press "Delete criterion group" context menu item;

Press toolbar button ;

Press DELETE key.

Press Yes button in the opened "SociometryPro" window for deleting a criteria group.

Press Cancel button if you don't want delete a criteria group.

Press Help for opening of the context helper window.

4.4.5. Criterion

A criterion is one of the general objects of a sociometric investigation. It's a sociometric testing 
question.

Adding a criterion

For adding a criterion select the node of criteria group, in which you want add the criterion, and
do one of the following:

Press "Object/Create criterion" main menu item;

Press "Create criterion" context menu item;

Press toolbar button ;

Press INSERT key.

Input the criterion name and description (optional) in the opened "Adding a criterion" window.
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Press OK button for creating a criterion.

Press Cancel button if you don't want create a criterion.

Press Help for opening of the context helper window.

Changing a criterion

For changing a criterion do double clicking over the node of the criterion. Or else select the 
criterion node by mouse left button or keyboard and do one of the following:

Press "Object/Change criterion" main menu item;

Press "Change criterion" context menu item;

Press toolbar button ;

Press ENTER key.

Change the criterion name and description (optional) in the opened "Changing a criterion" 
window (it is almost the same as "Adding a criterion" window).

Press OK button for changing a criterion.

Press Cancel button if you don't want change a criterion.

Press Help for opening of the context helper window.

Deleting a criterion

Only a criterion, which isn't related to an investigation, can be deleted.

For deleting a criterion do double clicking over the node of the criterion. Or else select the 
criterion node by mouse left button or keyboard and do one of the following:

Press "Object/Delete criterion" main menu item;

Press "Delete criterion" context menu item;
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Press toolbar button ;

Press DELETE key.

Press Yes button in the opened "SociometryPro" window for deleting a criterion.

Press Cancel button if you don't want delete a criterion.

Press Help for opening of the context helper window.

4.4.6. Investigation

An investigation is a program reflection of sociometric testing. An investigation unites a clients 
group and a criterion.

Adding an investigation

For adding an investigation select "Investigations" node in the objects tree by mouse left button
and do one of the following:

Press "Object/Create investigation" main menu item;

Press "Create investigation" context menu item;

Press toolbar button ;

Press INSERT key.

Input the investigation name and description (optional) in the opened "Adding an investigation" 
window. As well you should point the clients group and the criterion of the investigation. For 
selecting a criterion first select a criteria group. Set "Enable negative choices" if you will 
provide the negative choices in the investigation. Set the value of "Maximum of choices" field, 
which is the maximal possible number of choices from a client in the group.
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Press OK button for creating an investigation.

Press Cancel button if you don't want create an investigation.

Press Help for opening of the context helper window.

Changing an investigation

For changing an investigation do double clicking over the node of the investigation. Or else 
select the investigation node by mouse left button or keyboard and do one of the following:

Press "Object/Change investigation" main menu item;

Press "Change investigation" context menu item;

Press toolbar button ;

Press ENTER key.

Change the investigation data in the opened "Changing an investigation" window (it is almost 
the same as "Adding an investigation" window).

Press OK button for changing an investigation.

Press Cancel button if you don't want change an investigation.

Press Help for opening of the context helper window.

Deleting an investigation
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For deleting an investigation do double clicking over the node of the investigation. Or else 
select the investigation node by mouse left button or keyboard and do one of the following:

Press "Object/Delete investigation" main menu item;

Press "Delete investigation" context menu item;

Press toolbar button ;

Press DELETE key.

Press Yes button in the opened "SociometryPro" window for deleting an investigation.

Press Cancel button if you don't want delete an investigation.

Press Help for opening of the context helper window.

4.4.7. Find a sociometric object

SociometryPro provides finding a necessary object in the objects tree. You can find a clients 
group, a client, a criteria group, a criterion or an investigation.

Finding first object

For finding first object press "Edit/Find" main menu item or toolbar button .

Input an object name or a part of the name only in "Find" field of opened "Find first" window. 
Select the object type by "Type" combobox control or leave its "Any" value if you don't want 
point the object type. If the search is case sensitive, then set "Case sensitive" field in active 
state. If you want find an object inputting the precise name, then set "Whole words only" field in
active state.
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Press Find button for finding an object. SociometryPro will find first object in the objects tree 
that is satisfying the input search rules.

Press Close button if you don't want find an object.

Press Help for opening of the context helper window.

Finding next object

After finding first object in the objects tree you can repeat the search with the same settings. 
For this select a node in the objects tree, from which finding will start, and press "Edit/Find 

next" main menu item or toolbar button . SociometryPro will find down the next object from
the selected one in the objects tree that is satisfying the input search rules.

4.5. Choices

4.5.1. Choices procedure

The choices procedure should be done for any investigation. During this procedure you should 
point choices in the choices window.

The only choices window can be opened for an investigation.

For opening the choices window select an investigation node in the objects tree and press 

"Object/Choices" main menu item or toolbar button .
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The choices window includes the choices table, which contains the list of clients of the 
sociometric investigation.

The direction of all choices is the same as the direction of the arrow in the left top corner of the 
choices table. Clients, from which the arrow is going out, are choosing those clients, to which 
the arrow is going in. The choices direction and other interface tunings can be changed in 
"Parameters" window.

A choice can be changed by single clicking of mouse left button over a cell of the choices 
table. In this way the cell value is changing in the following sequence: clear cell -> positive 
choice - > negative choice -> clear cell -> etc.

As well a choice can be changed by "Positive", "Negative" or "Clear" context menu items.

For deleting all choices in the table do one of the following:

Press "View/Clear all choices" main menu item;

Press "Clear all choices" context menu item;

Press the toolbar button .

If you changed choices in the table, then the program will ask you save them during closing the
choices window. If you cancel saving, then all last changes will be lost.
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You can save the changes not closing the choices window. For this do one of the following:

Press "View/Save choices" main menu item;

Press "Save" context menu item;

Press the toolbar button .

Press "File/Print" main menu item or toolbar button  if you want print current choices 
window.

4.6. Visualizing the testing results

4.6.1. Indexes

For opening an indexes window select an investigation node in the objects tree and press 

"Object/Indexes" main menu item or toolbar button .

It will result in arriving an indexes window with two charts: the group indexes chart and the 
private indexes chart. Initially indexes are displayed for positive choices only. For displaying 
indexes for other choices types do one of the following:

Press "View/Positive choices" main menu item (for displaying of positive choices indexes) or  
"View/Negative choices" main menu item (for displaying of negative choices indexes);

Press "Positive choices" context menu item (for displaying of positive choices indexes) or  
"Negative choices" context menu item (for displaying of negative choices indexes);

Press toolbar button  (for displaying of positive choices indexes) or  (for displaying of negative
choices indexes).
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You can create a lot of indexes windows for an investigation. It provides easy comparing of 
sociometric data among different indexes windows, if between opening of them some choices 
of the investigation were changed.

You can change interface of indexes windows in "Parameters" window.

Press "File/Print" main menu item or toolbar button  if you want print current indexes 
window.

4.6.2. Graph

For opening a graph window select an investigation node in the objects tree and press 

"Object/Graph" main menu item or toolbar button .

It will result in arriving a graph window with graphic figures, many of which are connected by 
arrows. A figure is a reflection of a client in the group of the sociometric investigation. An arrow
is a reflection of a choice.

Initially graph is displayed for positive choices only. For displaying graph for other choices 
types do one of the following:

Press "View/Positive choices" main menu item (for displaying of positive choices graph) or  
"View/Negative choices" main menu item (for displaying of negative choices graph);

Press "Positive choices" context menu item (for displaying of positive choices graph) or  
"Negative choices" context menu item (for displaying of negative choices graph);

Press toolbar button  (for displaying of positive choices graph) or  (for displaying of negative 
choices graph).

You can create a lot of graph windows for an investigation. It provides easy comparing of 
sociometric data among different graph windows, if between opening of them some choices of 
the investigation were changed.
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A figure can be moved in the graph window. Do it as follows: press mouse left button, when the
cursor is over a figure, move the figure (moving the cursor and holding the left button in 
pressed state) to another place and release the mouse button.

You can resize figures as well. For this do single clicking over a figure. It will result in selecting 
the figure. Move the mouse cursor over a rectangle of the figure selection and move the 
rectangle in any direction. Observe how the figure sizes are changed.

When you open a first graph for new investigation, the figure types are defined in automatic 
mode. In future you can change type of any figure in the graph. Such info will be saved for 
each choices type.

Figure type can be changed by context menu. There are defined the following figure types:

7-star;

5-star;

Hexagon;

Pentagon;

Rectangle;

Triangle;

Oval.

If a figure name is finished by "...", hence, it's cut. For displaying of full figure name increase 
the figure size or decrease font size of figure names in "Parameters" window.

In "Parameters" window you can set displaying of positive choices and negative choices 
arrows in the graph of both types choices by differently (in this case different arrows width and 
color can be set). Another interface elements can be set in "Parameters" window as well.

Press "File/Print" main menu item or toolbar button  if you want print current graph window.

4.6.3. Target

For opening a target window select an investigation node in the objects tree and press 
"Object/Target" main menu item or toolbar button .

It will result in arriving a target window and its legend. When you are moving the mouse cursor 
over a target ring, the legend is displaying the clients list, in which each client got the number 
of choices as it's displayed on the active ring.

Page 37 from 53

http://www.ledisgroup.com/


SociometryPro's User Guide LeDiS Group, http://www.ledisgroup.com

You can select a target ring in another way as well. It can be done by single clicking over the 
ring. In this case if you move the mouse cursor out of the target, the legend will display clients 
in according the ring selected in this manner.

Initially target is displayed for positive choices only. For displaying target for other choices 
types do one of the following:

Press "View/Positive choices" main menu item (for displaying of positive choices target) or  
"View/Negative choices" main menu item (for displaying of negative choices target);

Press "Positive choices" context menu item (for displaying of positive choices target) or  
"Negative choices" context menu item (for displaying of negative choices target);

Press toolbar button  (for displaying of positive choices target) or  (for displaying of negative 
choices target).

You can create a lot of target windows for an investigation. It provides easy comparing of 
sociometric data among different target windows, if between opening of them some choices of 
the investigation were changed.

You can change interface of target windows in "Parameters" window.

Press "File/Print" main menu item or toolbar button  if you want print current target window.

4.7. Reports

4.7.1. Printing a window

SociometryPro provides printing of a choices window, indexes window, graph window and 
target window. For printing of a window select an investigation node in the objects tree, open a 

child window for it and press "File/Print" main menu item or toolbar button .

In the opened "Print window" window you can choose print type and number of printing copies.
You can additionally tune the printer driver by pressing Features button.

SociometryPro provides 3 print types:

Common.
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The window image is printing approximately in the real size as it's shown in the computer 
monitor. But one must be mentioned that printing 1:1 isn't possible because of different 
features of many monitors and printers.

If the image is very big (bigger than paper list), then it will be located on several paper lists.

Proportional.

In this case the image is optimally located on the paper list. It's stretched to the paper list as 
much as possible with saving image's proportions.

Image printed in "Proportional" type is always located on the only paper list.

Fit to list.

In this case the image is optimally located on the paper list. It's stretched to the paper list as 
much as possible without saving image's proportions.

Image printed in "Fit to list" type is always located on the only paper list.

"Copies" control provides setting the number of printed copies.

Pressing on Features button results in arriving a printer driver window that can differ for 
different computers.

Press Print button for printing current window.

Press Cancel if you don't want print current window.

Press Help for opening of the context helper window.

4.7.2. Current object report

For creating a report of the selected node in the objects tree press "Report/Current node" main

menu item or toolbar button . SociometryPro detects the selected node type, launches 
Microsoft Word (if it's installed in your computer) and creates a Word document filling it by the 
current object's data.

4.7.3. Select an object for report

When you need create a report the program is asking you choose an object for the report. It 
can be done in "Object selection" window.

User can select a clients group for reporting as it's shown in the picture above. When user is 
creating a report for other objects, then the other objects lists will be formed: list of clients, 
criteria groups, criteria or investigations.

Press OK button for creating a report for the chosen object. SociometryPro launches Microsoft 
Word (if it's installed in your computer) and creates a Word document filling it by the object's 
data.
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Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.7.4. Clients group report

Press "Report/Client group" for displaying "Object selection" window. This window provides the
clients groups list, for which you can create a report.

Choose a clients group and press OK button for creating a report for this group. SociometryPro
launches Microsoft Word (if it's installed in your computer) and creates a Word document filling
it by the clients group's data.

Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.7.5. Client report

Press "Report/Client" for displaying "Object selection" window. This window provides the 
clients list, for which you can create a report.

Choose a clients and press OK button for creating a report for this client. SociometryPro 
launches Microsoft Word (if it's installed in your computer) and creates a Word document filling
it by the client's data.

Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.7.6. Criteria group report

Press "Report/Criterion group" for displaying "Object selection" window. This window provides 
the criteria groups list, for which you can create a report.

Choose a criteria group and press OK button for creating a report for this group. 
SociometryPro launches Microsoft Word (if it's installed in your computer) and creates a Word 
document filling it by the criteria group's data.

Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.7.7. Criterion report

Press "Report/Criterion" for displaying "Object selection" window. This window provides the 
criteria list, for which you can create a report.

Choose a criterion and press OK button for creating a report for this criterion. SociometryPro 
launches Microsoft Word (if it's installed in your computer) and creates a Word document filling
it by the criterion's data.

Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.7.8. Investigation report

Press "Report/Investigation" for displaying "Object selection" window. This window provides 
the investigations list, for which you can create a report.
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Choose an investigation and press OK button for creating a report for this investigation. 
SociometryPro launches Microsoft Word (if it's installed in your computer) and creates a Word 
document filling it by the investigation's data.

You can define the investigation report's structure in "Parameters" window.

Press Cancel if you don't want creating a report.

Press Help for opening of the context helper window.

4.8. Configuring SociometryPro

About Configuring

For opening a window "Parameters" press "Edit/Options" main menu item or toolbar button

. It provides tuning the program and current project.

"Parameters" window contains several pages. A page is related to a part of SociometryPro 
program. There are the following pages:

General

Objects tree

Choices

Indexes

Graph

Target

Report Builder

Press OK to set the changed parameters.

Press Cancel if you don't want set the changed parameters.

Press Help for opening of the context helper window.

General
The page includes controls for setting of general SociometryPro parameters and parameters of
the opened project ("Current project" group). If at the moment there isn't any opened project, 
then the controls of "Current project" group are disabled.

Set "Show tutorial starting SociometryPro" checkbox if you want the program display the 
context helper at the Tutorial page, when it started.

Set "Show starting window" checkbox if you want the program display the window of choosing 
an action, when it started.
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If a project is opened, then you can set "Login and password control opening project" checkbox
if you want set the authorization mode for the project.

Set the value in "Maximal number of projects in 'Open again'" field that defines now many 
projects should be displayed in the history of last opened projects.

If you input 0, then "Open again" main menu item become invisible. As well the item is invisible
if you never opened any project at current computer.

4.8.1. Objects tree

The page provides tuning of the objects tree interface.

"Element" listbox provides choosing an element for tuning in "Parameters" group.

You can tune the following elements:

Element Parameters

Background Color.

Node Font (caption, bold style, italic style, size, color).
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4.8.2. Choices

The page provides tuning of a choices window interface.

"Element" listbox provides choosing an element for tuning in "Parameters" group.

You can tune the following elements:

Element Parameters

Arrow Color, width, direction.

Cell (additional) Color, width, height.

Cell (choices) Color, width, height.

Line (active cell) Color, width.

Line (not active cell) Color, width.

Symbol (negative 
choices)

Font (caption, bold style, italic style, size, color), single symbol.
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Symbol (positive 
choices)

Font (caption, bold style, italic style, size, color), single symbol.

Text Font (caption, bold style, italic style, size, color).

4.8.3. Indexes

The page provides tuning of indexes windows.

"Element" listbox provides choosing an element for tuning in "Parameters" group.

You can tune the following elements:

Element Parameters

Background Color.

Group indexes axe X 
label

Font (caption, bold style, italic style, size, color).

Group indexes axe X 
title

Font (caption, bold style, italic style, size, color), title string.

Page 44 from 53

http://www.ledisgroup.com/


SociometryPro's User Guide LeDiS Group, http://www.ledisgroup.com

Group indexes axe Y 
label

Font (caption, bold style, italic style, size, color).

Group indexes axe Y 
title

Font (caption, bold style, italic style, size, color), title string.

Group indexes chart 
color

Color.

Group indexes chart 
grid

Color.

Group indexes data 
label

Font (caption, bold style, italic style, size, color).

Group indexes data 
label background

Color.

Group indexes title Font (caption, bold style, italic style, size, color), title string.

Legend Font (caption, bold style, italic style, size, color).

Legend background Color.

Private indexes axis X 
label

Font (caption, bold style, italic style, size, color).

Private indexes axis X 
title

Font (caption, bold style, italic style, size, color), title string.

Private indexes axis Y 
label

Font (caption, bold style, italic style, size, color).

Private indexes axis Y 
title

Font (caption, bold style, italic style, size, color), title string.

Private indexes chart 
color

Color.

Private indexes chart 
grid

Color.

Private indexes data 
label

Font (caption, bold style, italic style, size, color).

Private indexes data 
label background

Color.

Private indexes title Font (caption, bold style, italic style, size, color), title string.
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4.8.4. Graph

The page provides tuning of graph windows.

"Element" listbox provides choosing an element for tuning in "Parameters" group.

You can tune the following elements:

Element Parameters

Arrow Color, width.

Arrow (negative choice 
for common graph)

Color, width.

Arrow (positive choice 
for common graph)

Color, width.

Background Color.

Graph component 
background

Color.
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Graph component line Color, width.

Graph component text Font (caption, bold style, italic style, size, color).

4.8.5. Target

The page provides tuning of target windows.

"Element" listbox provides choosing an element for tuning in "Parameters" group.

You can tune the following elements:

Element Parameters

Active ring Color, width.

Active ring line Color, width.

Background Color.

Legend background Color.

Legend border Color, width.
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Legend text Font (caption, bold style, italic style, size, color).

Not active ring Color, width.

Not active ring line Color, width.

Ring text Font (caption, bold style, italic style, size, color).

4.8.6. Report Builder

The page provides tuning of an investigation report.

You can include in an investigation report the following:

Sociomatrix image (set "Include sociomatrix" checkbox);

Graph with positive choices image (set "Include graph image for positive choices" checkbox);

Graph with negative choices image (set "Include graph image for negative choices" 
checkbox);
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Graph with positive and negative choices image (set "Include graph image for both types of 
choices);

Indexes list for positive choices (set "Information about positive choices" checkbox);

Indexes list for negative choices (set "Information about negative choices" checkbox).

4.9. Author securing

4.9.1. About securing

SociometryPro should be register for work unlimited in time. You should register the necessary
number of copies in according with the license (it's installed together with SociometryPro).

If SociometryPro program isn't registered, then "Registration" window will arrive after starting 
the program. If the demo period isn't finished (it's active for 30 days after first running the 
program at current computer), then Demo button is enabled. It provides running the program in
demo mode.

The program functionality isn't limited during the demo period.

For registering the program you should get the register code from LeDiS Group. After getting 
the code input in "Registration" window your full name and registration code that you got from 
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LeDiS Group. In case of successful registration SociometryPro mess you and display the main 
SociometryPro window.

Press Exit if you want stopping the program.

Press Help for opening of the context helper window.
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5. Formulas for calculating the sociometric indexes

5.1. Personal (Private) indexes

5.1.1. About private indexes

Private indexes provide evaluating sociometric position of a client in a group, which is 
participating in sociometric testing. Indexes are values, calculated by special formulas.

SociometryPro calculates the following private indexes:

Weight

Emotional effusiveness

Satisfaction

Status

5.1.2. Weight

The index describes which part of the group defines the client with number i as valuable using 
some criterion.

, where Mi - the number of choices which client with number i have got, N - the 
number of clients in the group.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (client-i didn't get any choices).

Maximal index value: 1 (if Mi = N-1).

Range of index change: from 0 to 1.

5.1.3. Emotional effusiveness

The index describes which part of the group is valuable for the client with number i using some 
criterion.

, where Mi - the number of choices which the client with number i made; N - the 
number of clients in the group.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (client-i didn't make any choices).

Maximal index value: 1 (if Mi = N-1).

Range of index change: from 0 to 1.

5.1.4. Satisfaction

The index describes, which part of choices, made by the client with number i, is mutual.
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, where Mi - the number of mutual choices (when the clients choose each to other) for 
the client with number i; Ki - the number of choices which the client with number i made.

The index is significant if the client made at least one choice. Then:

Minimal index value: 0 (client-i don't have any mutual choices).

Maximal index value: 1 (obviously, that Mi <= Ki is always true).

Range of index change: from 0 to 1.

5.1.5. Status

The index describes how much the client with number i is attractive for others.

, where - the number of positive choices, which client with number i have got;

 - the number of negative choices, which client with number i have got; N -the number of 
clients in the group.

You can see that the index depends on positive and negative choices simultaneously. Its value
is always the same both for positive and for negative choices.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (client-i didn't get any choices).

Maximal index value: 1 (client-i got all possible choices, the number of which is N-1).

Range of index change: from 0 to 1.

5.2. Group Indexes

5.2.1. Group indexes

Group indexes provide evaluating the sociometric status of a group of people participating in 
the investigation. Indexes are values, calculated by special formulas.

SociometryPro calculates the following group indexes:

Density

Cohesion

Stability

Intensity

5.2.2. Density

The index describes the density of inner relations in the group.

, where M - the number of choices; N – the number of clients in the group.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (there isn't any choices in the group).
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Maximal index value: 1 (the number of all possible choices is equal N*(N-1) ).

Range of index change: from 0 to 1.

5.2.3. Cohesion

The index describes the strength of mutual attraction of clients in the group.

, where - the number of mutual positive choices; N - the number of clients in 
the group.

You can see that the index depends on the positive choices. . Its value is always the same 
both for positive and for negative choices.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (there isn't any positive choices in the group).

Maximal index value: 2 (the number of all possible choices is equal N*(N-1) ).

Range of index change: from 0 to 2.

5.2.4. Stability

The index describes, which minimal part of the group must be removed to divide the group to 
unrelated parts.

, where M - the number of non-mutual choices; K - the number of pairs of mutual 
choices; N - the number of clients in the group.

5.2.5. Intensity

The index describes the value of dissatisfaction of clients by emotional relations in the group.

, where M - the number of choices; K - the number of pairs of mutual choices;
N - the number of clients in the group.

The number of clients is usually more 2 and more several tens. Then:

Minimal index value: 0 (all made choices are mutual).

Maximal index value: 1 (the maximal number of choices of one type without mutual choices is

 and K=0).

Range of index change: from 0 to 1.
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